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Instructions for Use in Electronic Format (eIFU)

	 	 The electronic data (PDF document) of the Instructions for Use is available. Scan the following QR 
code and visit our website.

	 In order to view PDF documents, you will need the free Adobe Acrobat Reader distributed by 
Adobe Inc. Download the latest version via the Adobe website. PDF documents may not be 
displayed correctly using previous versions.

https://www.morita.com/jmmc/en/support/download-center/?filterTagIds=219&categoryid=579
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Thank you for purchasing the i-Dixel software.

For optimum safety and performance as well as to avoid causing harm to people, read this manual thoroughly 
before using the software and pay close attention to warnings and cautions.
Keep this manual in a readily accessible place for quick and easy reference.

The volume rendering software included in this application was developed by J. MORITA MFG. CORP. in collaboration 

with Professor Kensaku Mori of the Nagoya University Department of Media Science.

*	This manual is Instructions for Use for i-Dixel. 
Refer to the reference note for more technical detailed explanations.

Click

Double-Click

Description of Icons

Trademarks and Registered Trademarks: 

Parts of the names of companies, products, services, etc. used in this manual may contain either trademarks or registered 

trademarks owned by each company.

© 2010  J. MORITA MFG. CORP.
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The user (hospital, clinic etc.) is responsbile fo the operation and maintenance of medical devices. 
This equipment must be used only by legally qualified professionals such as doctors and dentists. 

1.1  Do Not Fail To Observe The Following Cautionary Remarks
•	 J. MORITA MFG. CORP. is the legal registered owner of i-Dixel software and does not permit unauthorized 

reproduction of it.
•	 J. MORITA MFG. CORP. cannot be held liable for problems or malfunctions attributable to the OS (operating 

system).
•	 J. MORITA MFG. CORP. bears no responsibility for problems attributable to factors arising from the operating 

environment established by the user.
•	 This software is not compliant with the Windows standby mode or with the unique standby modes for notebook 

computers.
•	 Do not use a screen saver; screen savers may prevent the software from running smoothly.
•	 Do not use controls for automatically turning off the display and hard disk which are in the screen saver section 

of the display control panel.  These should both be disabled and not used; otherwise the software may not run 
smoothly.

•	 Do not use “Sleep” or “Suspend” functions; the software may not run smoothly if these are turned on.
•	 The quality of printed images and how long they can be kept good-conditioned depend on the applied printer 

and paper and storage method of printed images.  We shall not be liable to them.
•	 The J. MORITA MFG. CORP. bears no responsibility for problems and defects originating with hardware items 

such as the computer itself or peripheral devices or for problems and defects which seem to originate with 
such hardware items.

•	 This software has only been verified to run on Microsoft's Windows 10, Windows 11, Windows Server 2012 
R2, Windows Server 2016, Windows Server 2019, and Windows Server 2022 operating systems. There is no 
guarantee for other operating systems. Also, Microsoft's .NET Framework 3.5 or later must be installed.

•	 This software utilizes Microsoft SQL Server (2014 and 2019), a database engine, and Microsoft Access Driver 
from Microsoft Corporation.

•	 The warranty for this software will not extend more than 1 year after the manufacturer of the operating system 
(OS), which has been proven to work, has discontinued sales of the operating system regardless of the original 
valid period of the warrantee.

•	 i-Dixel Viewer cannot be used for diagnostic purposes.
•	 i-Dixel software needs a USB key to run properly; connect the USB key before starting the application.  (On 

some computers the USB connectors are on the back.)
•	 If you start the i-Dixel application without connecting the USB key, it will start in demonstration mode and some 

features may be disabled or inaccessible. In this case, close the i-Dixel application, connect the USB key and 
then restart the application.

•	 Note, in some configurations, there will only be 1 USB key for the network. As before, ensure it is plugged in 
otherwise all i-Dixel applications will operate in demonstration mode until remedied.

•	 The USB key is one component of the i-Dixel software package. If you lose or damage it, you will need to 
purchase a replacement key before using the i-Dixel application again.

•	 For network systems, turn on the i-Dixel server before you start i-Dixel on the client computer. If you start 
i-Dixel on the client computer first, you will not be able to access the network database.

1  Disclaimers
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1.2  Preventing Accidents
Most operation and maintenance problems result from insufficient attention being paid to basic safety pre- 
cautions and not being able to foresee the possibilities of accidents.
Problems and accidents are best avoided by foreseeing the possibility of danger and operating the software in 
accordance with the manufacturer’s recommendations.
First thoroughly read all precautions and instructions pertaining to safety and accident prevention; then, operate 
the equipment with the utmost caution to prevent either damaging the equipment itself or causing bodily injury.

The following symbols and expressions indicate the degree of danger and harm that could result from ignoring 
the instructions they accompany:

	 This alerts the user of the possibility of a hazard with a medium risk of injury or death 
if not avoided. This also alerts the user of the possibility of a hazard with cybersecurity 
incident including privacy protection.

	 This alerts the user of the possibility of data or database corruption or damage to the 
equipment, as well as handling precautions.

1.3  Precautions

•	Be sure to control the network environment properly and prevent inappropriate connections with non-related computers, 
etc. Taking effective measures such as entry and exit management is advised.

•	To secure network safety, be sure to divide the network properly and avoid inappropriate connections from non-related 
persons.

•	To prevent inappropriate connections with non-related computers, etc., be sure to protect and monitor unused ports such 
as LAN ports. To prevent unauthorized access from Wi-Fi networks, be sure to manage authorized computers’ MAC ad-
dresses on the Wi-Fi router.

•	To prevent unauthorized access to the operating system (e.g., Windows OS), be sure to set up a strong password for 
the user account.

•	If the authentication setting for i-Dixel is turned off, be sure to take measures against unauthorized login to the operating 
system (e.g., Windows OS).

•	If connected computers are able to access the Internet or external storage devices (e.g., USB mass storage drive), be 
sure to take measures against computer virus and malware attacks.

•	i-Dixel installation should only be performed by personnel properly trained in the installation process.
•	When disposing of computers, be sure to destroy the storage device (e.g., HDD) to prevent a data breach.
•	To prevent data breaches, take effective measures such as turning on data encryption (e.g., Windows BitLocker).
•	The operating system (e.g., Windows OS) and i-Dixel installation should only be performed by personnel properly trained 

in the installation process. Before updating the software, be sure to take an image backup of the storage device (e.g., 
HDD).

•	Security updates for the operating system (e.g., Windows OS) should only be performed by personnel properly trained in 
the security update process. Before connecting to the Internet, be sure to update the security settings on the operating 
system (e.g., Windows OS). Be aware that even for computers that are not connected to the Internet, there is a risk of 
virus and malware infection when connecting to an external storage device (e.g., USB mass storage drive).

•	Be sure to set up and manage credentials properly for the operating system (e.g., Windows OS) and the i-Dixel soft-
ware.

•	When you register a new patient or select a patient with i-Dixel, confirm that the patient and the data in the medical re-
cords correspond with each other.

•	Before adding a label (e.g., R or L mark) to an image, make sure the label direction and the patient direction match.
•	Before measuring the distance on an image, make sure that both the image pixel size (resolution) and magnification 

ratio are correctly set. If these are incorrect or no information is set, be sure to modify the settings.
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•	If the image is flipped horizontally, the Flips horizontal button is displayed in orange.  Especially in case of the panorama 
image diagnosis, check the displayed status of the Flips Horizontal button to prevent the horizontal orientation misun-
derstanding.  For the digital panorama images, it is possible to add the R and L marks to the images at imaging if neces-
sary.  (To add the R and L marks, the service person must change the setting.) 

•	When you horizontally flip the panoramic image, the panoramic scout cannot be applied to it. Revert the image by flip-
ping it back to the original. Also, do not use images with the conditions listed below for the panoramic scout. As these 
images do not contain horizontal flip information, the panoramic scout cannot be processed correctly.

•	 Imported panoramic images that have been horizontally flipped.
•	 Images that were horizontally flipped and saved as a new image by the i-Dixel software version 2.360 or earlier.

•	“AGS” automatically optimizes density regardless of the region.  However it is not suitable for inflammation over a large 
area such as odontogenic maxillary sinusitis (maxillary sinusitis due to dental caries), asymmetries etc.  In these cases, 
diagnosis should be based on observation of images both before and after “AGS” processing.

•	Watch out for errors in distance measurements due to X-ray exposure principles etc.  For accurate measurements, one 
must take care how the measurements are made. For details, see  p. 68  “16.2  Technical Information for Distance 
Measurement”.

•	 An image taken with common X-ray equipment will be enlarged against the actual size of the subject. Without correctly 
understanding this point, distance measurement, printing, and image export might yield unintended results. For details, 
see  p. 77  “16.3  Image Size Technical Information for Distance Measurement, Printing, and Image Export”.

•	Without correctly understanding the magnification ratio for the panoramic image, the panoramic image data might yield 
unintended results. For details, see  p. 77  “16.4  Technical Information for Panoramic Image Magnification 
Ratio”.

•	Without correctly understanding the magnification ratio and distance measurement accuracy, distance measurement 
might yield unintended results. For details, see  p. 78  “16.5  Technical Information for Image Magnification Ratio 
and Distance Measurement Accuracy”. 

•	Implant overlay drawing is only for presentation purpose not actual planning.
•	Depictions of implant devices in X-ray images are only for explanations to patients and may not be accurate enough for 

actual planning. 
•	Implant devices displayed may not be available or may not be suitable. Ask makers of implant devices about availability 

and suitability.
•	The user is responsible for how this software and the implant display feature are used for patient explanations and treat-

ment.
•	In pseudo CT value calculation, the amount projecting from the imaging area of the subject and the errors in location are 

included in the calculation as approximations, so in terms of accuracy, it is not as reliable as medical X-ray CT.  How-
ever, as the contrast is stable, it offers greater utility for data exchange with other workstations using DICOM.

•	Note that there may be some discrepancy between measured lengths and actual lengths due to the principles of CT ra-
diography, CT slice thickness and other reasons.  One must handle measured lengths carefully to arrive at an accurate 
measurement.  For details, see  p. 68  “16.2  Technical Information for Distance Measurement”.
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•	This document describes i-Dixel functions as well as one part of the X-ray equipment’s modality functions, such as pan-
orama tomographic focal plane adjustment. For more information about modality functions, refer to the separate Instruc-
tions for Use of the X-ray equipment.

•	Databases are stored on the hard disk.  Since the service life of hard disk is limited, be sure to create a backup of valu-
able data every day. 

•	According to the format that you have selected, the quality of the exported image and that of the image displayed on the 
screen may look different.  After executing export, check for any problems of the quality of exported image.  To prevent 
the quality of exported images from being deteriorated, use BMP format to export them.

•	Before exporting data to any other removable media or to a folder on the network, be sure to prepare the media or folder 
to which the data will be exported and make sure that the data can be read from it.  Especially be careful about external 
memories connected via a USB port.

•	When using the video capture function, select the image size 640×480 or 320×240 at the driver setting.  If you select any 
other image size, the aspect ratio of the image window may become improper, hindering diagnosis.  For setting details, 
refer to the Instructions for Use for the capture board.  Even if you click “Save” in the part setting window, the setting will 
not become effective unless you save the intended image. 

•	To use TWAIN, connect TWAIN equipment and install the driver software.  For details, read the Instructions for Use of 
the TWAIN equipment. 

•	Since other filter-applying processings such as Hi.Pass, UltlaHi, Lateral, Lo.Pass, UltraLo and Reduce incorporate fre-
quency processing, it takes a long time to process any large image using such a filter.

•	Since the quality of the images acquired from any modality manufactured by us are adjusted to be optimal, they do not 
need filter-applying processing and gamma processing.  Use such a filter-applying processing to scanned or imported 
images of the poor quality.

•	Since the load of backup processing is high, the speed of re-drawing on an image becomes extremely slow during 
backup processing. Do not start up any other application during backup processing.

•	The backup processing is not set up at shipment.  Set up the backup processing according to the operation conditions. 
•	As for generation-controlled backup, the backup data of the specified number of generations will be preserved.  We rec-

ommend you to select the generation control suitable to the way of backup repetition.
•	Any images moved using the “data move” function cannot be backed up by the “backup” processing.  Create a backup 

of such an image by using another function of the computer (for example, copying it using the copy function). 
•	To find the data move destination, it may take about 20 minutes.  If you have stored data on any other removable media 

or on a folder on the network, be sure to prepare the media or folder to which the data will be moved and make sure that 
the data can be read from it preliminarily.  Especially be careful about external memories connected via a USB port. 

•	Acquisition of data from any other memory takes some time from access to it.  When you have attempted data acquisi-
tion operation, if the data cannot be acquired immediately, wait for a while and then redo the operation.

•	Limitation of functions of i-Dixel demonstration version:
•	The i-Dixel demonstration version accommodates registration of only one patient.  Also, note that the CT-related func-

tions (optional) and DICOM-based functions (optional) are disabled. 
•	When there is not enough free space on the hard disk, you cannot save any other image data or any saved image data 

may be eliminated.  When a dialogue indicating that there is not enough free space on the hard disk appears, move im-
age data.

•	If you improperly operate a database, data saving may become disabled or saved data may be eliminated. First under-
stand the operation to be executed well, and then start operating the database.

•	If you manually operate any file inside a database file (a file with an extension .3dxdb or .3dxcs), the database will be 
destroyed and the data will be lost.  We shall not be liable in this case.  Unless you aim to delete any data file, do not 
manually and directly operate the data file.

•	Be sure to create a backup or print a hard copy of the data saved on the computer.  If any failure should occur to the 
computer or its storage, the data would be lost and it would be difficult to recover the data.  We shall not be liable in this 
case. 

•	When you have set up the scheduled backup, be sure to turn on the computer at the scheduled backup time. If the com-
puter is not turned on at the scheduled backup time, backup operation will not be executed.  If you turn off the computer 
during backup operation, the database may be damaged.  We shall not be liable in this case.

•	Do not execute data acquisition or the like during backup operation.  The data may not be acquired properly.  We shall 
not be liable in this case. 

•	Exert sufficient care for storage of backup data and hard copies.  We shall not be liable to any failures due to improper 
storage of them. 

•	Do not execute any other processing during imaging or the like. 
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•	If there are more than 15 CT slice thumbnail images in the basket, there may not be enough memory, and you may not 
be able to make a CT exposure or may not be able to reconstruct CT data.  To avoid this, remove unnecessary CT slice 
thumbnail images in the basket.

•	If there is not enough empty space on the hard disk, you may not be able to save CT data or you may lose some of the 
CT data.  To avoid this and insure enough empty space on the hard disk, delete unneeded CT tasks or store them on a 
separate hard disk.

•	If you import images acquired by using devices of other companies, we assume no responsibility for the safety, 
performance, or accuracy of additional information of such images. When importing images, be sure to perform a 
connection test to confirm the safety, performance, and additional information required for the images to be imported, 
and if there are any problems, contact the manufacturer or distributor of the other company's device.  
If applicable, perform the following four connection tests: 
•	Patient name
•	Patient direction (image direction)
•	Geometric precision (length, angle)
•	Other items specified by the manufacturer of the other companies' devices

•	Our image processing software functions (AIE-HD, AGS, etc.) are optimized for our devices, so do not apply these 
functions to images imported from devices of other manufacturers. If these functions are applied to other images, we 
assume no responsibility for the safety, performance, or accuracy of additional information of such images.

1.4  In Case of Accidents
For customers who use the i-Dixel in the EU:
If any serious incident occurs in relation to the device, report it to a competent authority of your country, as 
well as the manufacturer through your regional distributor. Observe relevant national regulations for detailed 
procedures.

1.5  User Qualifications
a)	 Qualification:

Legal qualified person such as a medical doctor, a dentist, a radiologic technologist, a nurse and a dental 
hygienist (it may differs among countries), Staff of medical institute and IT system administrator

b)	 Language understanding:
English and official language of the medical institution

c)	 Education, Knowledge, Experience and Training:
User does not need anything special except for understanding the IFU and basic computer operation, if not 
required by legal regulation.
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1.6  Version and Other Information
By clicking on “MORITA” mark displayed at the upper right corner of the Home screen, you will be able to confirm 
the version of i-Dixel and the currently connected database. 
When you wish to make an enquiry regarding the operations for the i-Dixel software, please inform the operator 
the Version and NetID for the i-Dixel software.

 ● Dialog of version information and details
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2  Start Up and Shut Down
Start Up
1 	 Turn on the computer and its peripheral devices

2 	 Double-click the i-Dixel icon.  A log-in window will appear.  Enter the account name and password.  The 
Home screen will then appear.

Shut Down
Click the “X” in the upper right corner to shut the application down. 

 ● Home screen:
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1 	 Click the “Settings window” button (  ) displayed in the Home screen.

	 In the “Staff” tab, you can have the staff information displayed, registered, and edited.

•	Be sure to set up and manage credentials properly for the operating system (e.g., Windows OS) and the i-Dixel software.

2

1 2 8

3

4

5
6 7

3  Staff Certification
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1 	 “New”: 
When you wish to register a new staff, click this button to display a “New” window. 

2 	 “Edit”: 
When you wish to edit an existing staff, click this button to display the “Edit” window.

3 	 Staff ID:
This column will be available when newly registering a staff; once the “ID” is entered, the “Register” 
button will be available.  This column will not be available when editing existing users.

4 	 “Address 1, 2”: 
Please do not use this charactor “@.”

5 	 “Type”: 
You can select from the list of qualifications. 

6 	 “Account”:
Make the setting as for whether to make this account valid as a certification account for when activating 
i-Dixel. 

7 	 “Set password”: 
Set whether to display the password window when activating i-Dixel. 
If you place a tick here when you are making a new registration or when you are editing existing 
accounts, the “Set password” window will be displayed after you have clicked the “Update” button.

8 	  “Authorization”: 
To activate the Authentication button, click the box for “Use the current user’s authority”.

*	 Only users designated as administrators (admin) can check this box.
Clicking this button will open up the “Authority” window.
Use this window to set the authorities available to users with various qualifications.

For example, you can remove the checks for “Patient list”, “Add”, “Update”, and “Delete” under the 
“dentalHygienist” heading and click “OK” to make these authorities unavailable to users with that 
qualification.
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4  Register and Edit Patient Data
4.1  Register New Patient
1 	 Click the “Patient registration window” button.

2 	 Enter the required data and then click the “Register” button. 
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3 	 Patient Page for a currently registered patient

 ● Patient Page Features

1 	 Navigation Bar
2 	 Task Panel
3 	 Basket

2

3

1
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4.2  Edit Patient Information

1 	 Display the Patient Page. 
Refer to 5  Find a Patient for how to find patients and display their Patient Pages.

2 	 Click the “Edit Information” button:   
(The patient ID (“ID”) cannot be changed.)
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5  Find a Patient
Enter the patient’s ID, name or part of his name in the search field and then click the search button:    
The page for the patient will open. (You can use the “Show Number Pad Button” to enter the patient’s ID.)

1 	 “Show Number Pad Button” 
2 	 Search Field
3 	 “Show Number”
4 	 Patient Information Display Area 

Check the patient’s name and ID.

*	If two or more patients match the search criteria, a list of their names will appear.  Double-click one of the 
names to display the corresponding Patient Page.

1

3

4

2
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*	If the patient information display area is not displayed in the center of the Home screen when searching for 
patients, the Patient List will be displayed even if there is only one patient who meets the search conditions. If 
you select a patient by double-clicking them on the Patient List, the Image Thumbnail Window will appear.
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6.1  Read-in an X-ray image
1 	 Make the X-ray exposure while the image list is being displayed. The X-ray exposure will automatically be 

transmitted to the computer and acquired by the i-Dixel application.
*	Refer to the Instructions for Use of the X-ray unit for how to make various types of exposures.

2 	 Click on the button for the “2D Viewer” to display the image. (A thumbnail of the image will appear in the 
Basket.)

1 	 “2D Viewer” Display
2 	 Thumbnail

1

2

6  Image Acquisition
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6.2  Applying Image Filters
“Filter” buttons are in the “Filter” section of the “2D Viewer”.

	Example: “Sharpness Filter” 
Click the “sharpness filter” button to apply it:   
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	Example: “AGS” Image Adjustment
Click the “AGS” button to apply this filter:     
This adjusts the brightness so that not only the dental arach but the jaw bone and TMJ can be more clearly 
observed.

“AGS” is only for the “Panorama” and “PanoramaPlus” modalities but cannot be used for the quadruple TMJ 
images or maxillary sinus images.
To make settings for the “AGS” filter, click the “Detailed filter setup” button:    

•	“AGS” automatically improves the density for all regions.  However, it may not be suitable for some cases such as ob-
serving differences in symmetry or inflammation over a wide area that can affect the maxillary sinus due to dental caries.  
In these cases, compare images before and after applying the “AGS” filter to arrive at an overall diagnosis.
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	Example: “AIE” Correction
Click the “Apply AIE correction” button:    
Image quality is adjusted so the outlines are more prominent to better show the features of particular areas. 
This will reduce the shadows produced by vertabrae, the angle of the mandible etc.

“AIE” correction can only be used for “Panorama”, “PanoramaPlus” and “Cephalo” modalities.

To make settings for the “AIE” correction, click the “Detailed filter setup” button:  

	Example: “AIE HD” Correction
Click the “Apply AIE HD correction” button:   
In addition to the “AIE” correction adjustment, this will reduce the artifacts that appear near metal prosthetics.

This can only be used for “Panorama” and “PanoramaPlus” modalities.

To make settings for the “AIE HD” correction, click the “Detailed filter setup” button:    
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6.3  Patient’s Orientation: Confirm the Patient’s Orientation
You can confirm the direction of the patient whose 2D image is being displayed by confirming the human head 
model.

1

1 	 Patient orientation window (The human head model will be displayed)

In order to display the human head model, right-click in the patient orientation window.  Select “New” to have the 
human head model displayed.

*	You can change the direction of the human head model by dragging the human head model by the pointer.

•	Even if you click “OK” in the patient orientation window, the setting will not become effective unless you save the intend-
ed image.
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6.4  Save Images
After completing image processing, click the “Save” button:   
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6.5  Compare Images
	Example: Compare two images, one above the other.

1 	 Double-click an image on the Image List.  

	 This will start up the “2D Viewer” and the image will be displayed.  Now select another image from the 
Image List and do the same thing.
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2 	 Check that both images appear in the Basket 1 , and then click the “Tile Two Images Vertically” Button:  

 

3 	 Two images displayed, one above the other.

1
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7  Import Images
1 	 Open the Patient Page to the Image List view. Click the “Import” button 1  and then select “2D Import” 2 . 

2 	 Select the radio button for “Select date and modality for each image file”, and then click “Select”.

1

2
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3 	 Select the image you wish to import from the list in the “Open” Window and then click “Open”.

*	To select more than one image, hold down the Shift or Ctrl key and then click each of the images.

4 	 Enter the “Date” and “Modality” for the image in the dialogue box and then click “Import”.

1 	 “Date” : Check the box for “Import on image date” or use the pull-down menu to select the date.
*	This works only if the image is being exported by a computer that has the i-Dixel application.

2 	 “Modality” : Select from the pull-down menu.

1

2
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5 	 The image will be displayed by the “2D Viewer” when the import process has been completed.  
(Its thumbnail will appear in the Basket.)
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8.1  Using the Intraoral Camera; “Penviewer”
1 	 Open the Patient Page to the Image List view.

2 	 Turn on the “Penviewer” camera.

3 	 Watch the moving image in the display.  To make a still image, press the “Freeze” button on the “Penviewer” 
camera.  Now the still image will be displayed instead of the moving image.

4 	 To save the still image, press the “Freeze” button again.  A thumbnail of the saved image will appear in the 
Basket.

	 Double-click the thumbnail to display it with the “2D Viewer”.

8  Intraoral Camera
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Use the “Print Center” to print patient information and images.

Start Up
1 	 Open the Patient Page to the Image List view, and put the images you wish to print in the Basket 1 .

2 	 Click the “Print Center” button:     The page used for printing will appear.

Shut Down
To shut down the “Print Center”, click the “Home” button:   
This will take you back to the i-Dixel Home screen.

1

9  “Print Center”
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9.1  Templates for Printing
You can make your own templates for printing patient images and information.
Templates can be set up using boxes for patient information, images, diagrams, and comments.  Lines, circles, 
squares and other figures can also be added.

	

1 	 Patient object
2 	 Image type object
3 	 Other objects
4 	 Templates

9.2  Create a Template
From among the menu, select; “File” – “New”, and once the “Report2” tab is added to the upper part of the 
object display window, you will be able to create a new template.

*	You can make the template appear bigger or smaller by using the “Zoom” in the “View”. 	

1

4

2

3
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9.3  Arranging Boxes on the Template

9.3.1  Image, Patient, and Clinic Object Boxes
Arrange boxes for images on the template.
Images will conform to the size and location of the boxes when they are put in the template. 

1 	 Click the “Image Type” tab and then select the boxes for various types of images.

2 	 Drag the image type icon onto the template to make a box for that type of image.  You can change the 
sizes and locations of the boxes.

3 	 Drag the boxes for various types of patient information onto the template.  Click the “Patient” Tab and then 
drag the desired items onto the template. 

Arrange clinic 
information box
Click the “Clinic” 
Tab and then drag 
the item onto the 
template.
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9.3.2  Arrange Text Boxes & Draw Lines and Shapes
There are various tools for drawing lines and shapes and adding text to the template. 
Go to the “Objects” menu and select “Draw” or click on one of the tools on the Draw Tool Bar.  Then put the line, 
shape or text box on the template. 

 ● Draw Tool Bar
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9.4  Save Template
You can save the template to use again as many times as you please.
You can save templates by category.

1 	 Open the “File” menu and select “Save As Template”.

2 	 Either make a new category or select one of the categories that already exist. 
To make a new category, click “New Category” and enter a name for it.

*	When you click “New Category” the dialogue box shown below will appear.  
Enter a name for the new category and then click “Create”.

3 	 A dialogue box for saving the template will appear.  Enter a name for the template and then click “Save”.
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9.5  Putting Images on a Template
1 	 Open the “File” menu and click “Open Template”.  

Select a template from one of the categories and double-click it.

1 	 Categories
2 	 Template List

2 	 Click the “Image List” button:     
Click the images on the list you wish to put in the template.  They will go into the Basket.

3 	 Click the “Print Center” button:      
This will take you back to the “Print Center”.

2

1
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4 	 Drag the images from the basket to the boxes for them on the template.  
(The sizes of the images will match the sizes of the boxes.)

*	If you wish to change the size of an image back to its original size after putting in a box with a different 
size, right-click the image and select “Reset Size”. 

*	To put images in their boxes without changing their size, open the “Object” menu and uncheck the item, 
“Change Size to Match Template”. 
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9.6  Print

1 	 Select and Set Printer
	 Open the “File” menu and select “Page Set Up”. 
	 Select the printer to be used and set the size and orientation of the page.

2 	 Check the “Print Preview”
	 Open the “File” menu and select “Print Preview” or click the “Print Preview” button on the tool bar.  Then 

check the preview display.

3 	 Print
	 Open the file menu and select “Print”.
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	Quick Print
Annotations are automatically created and printed when you select the images and template for printing. 
*	When different image modalities are selected for printing, separate annotations are created for each modality.

*	Enable the quick print function by clicking the “Setting window” button:   
Then click the “General ” tab and check the print settings in the lower right part of the display.

 ● Example: Print an Intraoral Image
1 	 Click the “Image List” button:   

Then click one of the Intraoral images to put it in the Basket.

¥¥3DX-SERVER¥3dx_data
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2 	 Click the “Print Center” button:  

3 	 Select the template to create the annotations.

4 	 Annotations will be created automatically.  
Open the “File” menu and select “Print”.

*	Even when the annotations are created automatically, you can still make printer settings and see the 
print preview. 
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9.7  Save Image with Annotations Document
Images with annotations can be saved as image files and displayed with the “2D Viewer”.

9.7.1  Save as Document
After making the document, open the “File” menu and select “Save to Database”.

9.7.2  Retrieve a Saved Document

1 	 Click the “Image List” button:    
A thumbnail of the saved document will appear in the Image List.

2 	 Double-click the thumbnail to display it with the “2D Viewer”. 

3 	 Saved document is displayed.

*	You can perform the same image processing operations as for a regular 2D image.
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10.1  Read-in the CT exposure
1 	 Open the Patient Page to the Image List view, and then make the exposure. 

The exposure will be automatically transmitted to the i-Dixel application.
*	Refer to the Instructions for Use of the X-ray unit for how to make various types of exposures.

2 	 After the exposure data has been transmitted to the i-Dixel application, the dialogue box shown below will 
appear. Click “Yes” to reconstruct the image.

3 	 A thumbnail for the CT data will appear in the Image List. (You may use the “2D Viewer” or the “3D Viewer” 
for image viewing and processing.)

10  Acquire CT Image
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11.1  With the “2D Viewer”
1 	 Select the CT thumbnail in the Image List.  A thumbnail for it will appear in the Basket 1 . 

Go to the Navigation Bar 2  and click the “2D Viewer” button:  

2 	 The “X”, “Y”, and “Z” slices will be displayed by the “2D Viewer”.

2

1

11  Display the Image
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 ● “2D Viewer” Features

1 	 “Z” Slice
2 	 “Y” Slice
3 	 “X” Slice
4 	 Attribute Information

Move the cursor lines for the “X”, “Y”, and “Z” slices vertically or horizontally to display the corresponding 
slices. 

Example: Moving the “Z” Cursor down changes the “Z” slice image as shown 
below.

*	Changes made to CT slices can be saved in the same way as for 2D images

1

2 3

4

 : “X” Cursor Line

 : “Y” Cursor Line

 : “Z” Cursor Line
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11.2  With the “3D Viewer”
1 	 Select the CT thumbnail in the Image List.  A thumbnail for it will appear in the Basket 1 . 

Go to the Navigation Bar 2  and click the “3D Viewer” button:  

2 	 The “3D Viewer” will display the “X”, “Y”, and “Z” slices and a volume rendered image.

1 	 Volume Rendered Image

2

1

1
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In the “3D Viewer” screen, you can show the data in “XYZ”, “CurvedMPR”, or “Dual-CMPR” Views.  You 
can switch the views by selecting the corresponding tabs as shown.

 ● “XYZ” View
For viewing and processing slice images and the volume rendered image.

 ● “CurvedMPR” View
For creating and processing a panoramic image and cross sections
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 ● “Dual-CMPR” View
In the “Dual-CMPR” View, you can add a pair of images (panoramic image and cross section images).
“CurvedMPR” and “MPR” can be done sequentially, with the generated panoramic and cross-section 
images displayed side by side. 
For processing multiple panoramic and cross section images.
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11.2.1  Histogram Window
In the histogram window you can adjust the brightness / contrast of the grayscale images, and set the“VOI” ( 
Volume of Interest ) you wish to display in the volume rendering window.  Click the “Grayscale” tab or the “Color” 
tab.

	Adjust Grayscale Image Brightness and Contrast

1 	 Contrast Line: Rotate towards vertical to increase contrast
2 	 “WL” (window level): Move left for brighter image or right for darker image
3 	 Brightness Level: Move up for brighter image or down for darker image

*	A grayscale image is a CT slice, “MIP”, or “RaySum” image displayed in “XYZ” View or an axial,panoramic, 
or cross section image displayed in “CurvedMPR” View or “Dual-CMPR” View.

	Set “VOI” for Volume Rendered Image

1 	 Histogram
2 	 Opacity Curve
3 	 Opacity Level Slider
4 	 CT Volume Data for the Voxel Value
5 	 “VOI” List
6 	 Settings for “WL”, “WW”, “Sh”
7 	 Buttons to Select Shape of Opacity Curve

*	“Sh” can be set only for the trapazoidal opacity curves:    

1

2

3

1
2 3

5

6

7

4
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 ● Processing for Volume Rendered Images

Example: Show Dentition Only

Move the Opacity Level slider 1  up or down until only the dentition is displayed.

If necessary, move the “WL” (Window Level) 1  or “WW” (Window Width) 2  to the left or right so that the entire 
area is visible.

1

1

2
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11.2.2  Rotate Volume Rendered Image
Drag the image up and down or left and right with the mouse. 
If you drag with the Ctrl key held down, you can rotate the image clockwise or counterclockwise. 
The head at the lower left shows the orientation of the image.

	“Auto-Rotate” with Button
Click the “Set the volume orientation” Button:    
Select the position for desired.

Drag mouse pointer 
with Ctrl held 
depressed.

1 	 Original CT Position

2 	 Position when data was closed previously

3 	 Forward

4 	 Back

5 	 Top

6 	 Bottom

7 	 90 degrees left

8 	 90 degrees right

1

3

5

7

2

4

6

8
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12.1  Create Panoramic and Cross Section Images
Use the CT data to create a panoramic and cross section images along the dental arch. 

•	The time it takes to produce panoramic and cross section images depends on the performance ability of the computer.

1 	 First set the “Z” slice in the “XYZ” View at the desired level.

2 	 Click the “Draw spline curve” button (  ) in “Tools” to change to “CurvedMPR” View.

12  “CurvedMPR” 
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3 	 Click along the dental arch in the axial image to draw the spline.  The mouse cursor will change to a plus 
sign when it is over the axial image.  Click on multiple points along the dental arch.  Then, these points will 
be connected.  Double click to mark the end of the spline. 
When finished, the corresponding panoramic and cross section images will be created. 

1 	 “Z” Slice
2 	 Panorama
3 	 Cross Sections
4 	 Perpendicular Lines
5 	 Spline

*	After you finish drawing the spline, numerous lines perpendicular to the spline will appear in the “Z” slice 
image.  The lines correspond to the cross-sections created.  The spacing of the these lines indicates the 
interval of the cross sections and their length indicates the width of the cross sections. 

*	The panoramic image corresponds to the spline.

  

1 2

3

15

4
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12.2  Create Mid-sagittal Line for Panoramic Image

1 	 Right-click the panoramic image.  Select “Mid-sagittal Line” from the pop-up menu.

2 	 A vertical white line will appear on the panoramic image.  Drag this line to the desired position.

*	When you set the mid-sagittal line, the cross section images on the left side of the line will face to the left 
and those on the right side, to the right.
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Unlike “CurvedMPR” View, you can create two “CurvedMPR” and “MPR” sets in the “Dual-CMPR” View.  
“CurvedMPR” and “MPR” can be done in sequence, with the generated panoramic or cross-section images 
displayed side by side.

1 	 In “XYZ” View, move the “Z” cursor line to the desired position to display the “Z” slice image to draw the 
first spline curve on.

2 	 Click the “Dual-CMPR” tab to switch to “Dual-CMPR” View.

13  “Dual-CMPR”
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3 	 Click the “Draw spline curve” button (  ) in “Tools” and draw the first spline curve 1 .  The drawing 
method is the same as for generating and displaying panoramic images and cross sections in “CurvedMPR” 
View.

	 When you have finished drawing the spline curve, “CurvedMPR” and “MPR” will execute, and the 
generated panoramic image and cross section images will be displayed on the left of the screen.

4 	 Move the “Z” cursor for the panoramic image you generated (the red line) up or down to set the position to 
draw the second spline curve.

1
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5 	 Click the “Draw spline curve” button (  ) in “Tools” and draw the second spline curve 2 .

	 When you have finished drawing the second spline curve, “CurvedMPR” and “MPR” will execute, and the 
generated panoramic image and cross sections will be displayed on the right of the screen.

 
2
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14.1  Draw Neural Tubes and Implants
You can make a presentation to show a patient your implant plan.  You can mark the mandibular canal to check 
its position and then place an implant that will appear in all CT images.

•	To mark the mandibular canal the slice thickness must be 1.0 mm or less.  Right-click a slice image.  Select the thick-
ness from the pop-up menu or select Custom.  Enter the desired “Thickness” in the “Custom Thickness” dialogue box.

	Example: Marking the mandibular canal and placing an implant for tooth 
36.  Implant: “Thommen Medical AG, SPI Contact” 4.13.224 and 4.23.224, 
11.0 mm length, 3.5 mm diameter.

1 	 Use the “3D Viewer” to display the Volume Rendered image.

2 	 Move the “X”, “Y”, and “Z” cursors and rotate the images so that the mandibular canal is clearly shown.

14  Implant Presentation
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3 	 Click the “Mandibular Canal” button:     
Place the mouse pointer on the starting point for the canal.  The mouse pointer will change to a small 
circle. 

	

4 	 Right-click on the starting point for the canal.  Continue right-clicking along the canal.  The points you click 
will be connected with a line showing the canal. 

5 	 To finish drawing the canal, click the “Select ” button:  
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6 	 The images will be converted to “MIP” images. 
To place an implant in the images, first line up the “X”, “Y”, and “Z” cursors with tooth 36. 

	 It is easier to see the mandibular canal in an “MIP” image than in volume rendered or raysum images.

7 	 Click the “Select Implant” button:   
	 A window for selecting implants will appear.



61

8 	 A preview image of the implant fixtures will appear.  Click “Create” to use it. 

9 	 The implant fixture will appear where the “X”, “Y”, and “Z” cursors intersect.
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10 	 A “handle” 1  will appear when you click the implant. 
	 Drag the implant itself to change its position; drag the “handle” to adjust its angle.

1
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14.2  Implant Presentation using “CurvedMPR” View or “Dual-CMPR” View
The mandibular canal can be marked in the “CurvedMPR” View or the “Dual-CMPR” View to make an implant 
presentation.

 ● “CurvedMPR” View

 ● “Dual-CMPR” View
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14.2.1  Mark Mandibular Canal for Panoramic and Cross Section Images
Click the “Mandibular Canal” button:  

Right-click on points along the mandibular canal.

•	To mark the mandibular canal the slice thickness must be 1.0 mm or less.  Right-click the slice image and select the 
thickness from the pop-up menu.

14.2.2  Implants
Implants can be shown all CT images in the “XYZ” View, cross sections in the “CurvedMPR” View and the axial 
image for the “Dual-CMPR” View.

	Example: Show Implant in Cross Section Image

	 Click the “Select Implant” button (  ) and select one of the implants.  
	 Then Adjust the position and orientation of the implant in the image.
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15  Magnify Slice Images of the “VOI”
15.1  Create Magnified Slice Images for a Specified “VOI” (Volume of Interest)

1 	 In the “3D Viewer”, line up the “X”, “Y”, and “Z” cursors with the center of the “VOI”.

2 	 Click the “Show or hide the FOV region” button:   
	 Drag the sides of the “FOV” frame to adjust its size. (“FOV”: Field of View) 
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3 	 Double-click the “FOV” frame to create magnified slice images.  A cube will appear on the volume 
rendered image to indicate the location of the magnified slices. 
*	Double-click one of the magnified images to return to the original display.

*	Double-click a partial slice image to restore it to its original.
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15.1.1  Change Location of “FOV” (Field of View)
After adjusting the size of the “FOV” as described in step 2 above, you can change is location by moving the “X”, 
“Y”, and “Z” cursor lines.

15.1.2  Change Size of “FOV” (Field of View)
Hold down the Ctrl key, Alt key and the right mouse button and drag on the image to change the size of the “FOV” 
without having to repeat the entire partial slice image procedure.
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16  Technical Information
This chapter describes technical information for using the i-Dixel software.
This chapter contains technical safety information. 
Read  p. 7  “1.3  Precautions” for more details.

16.1  Specifications
*	Specifications and appearance are subject to change without notice due to improvements.

Model i-Dixel

Intended use
i-Dixel can be used as viewer or database of medical imaging to support the diagnos-
tic by medical imaging.

Essential functions Display, edit and input/output 2D images and input/output CT slices (optional)

Computer OS
Microsoft Windows 10 Professional/Enterprise, Microsoft Windows 11 Professional/
Enterprise, Windows Server 2012 R2, 2016, 2019, or 2022

Combination device Medical devices manufactured or approved by J. MORITA MFG. CORP. and so forth.

Manufacturer: J. MORITA MFG. CORP.

16.2  Technical Information for Distance Measurement
There may be some difference between actual distances and measured distances due to computation, exposure 
principles etc.  This is explained below.

16.2.1  Computational errors for distance measurements
Distance measurements are made by clicking two pixels in the image.
The distance is calculated using the coordinates of the two pixels, the magnification ratio, and the pixel size 
(resolution).  The formula used is shown below:

*	 X1 and Y1 are the coordinates for the first pixel clicked. 
X2 and Y2 are the coordinates for the second one.

The following is an example of the calculation and how an error occurs.

 ● Calculation error 1
In the following calculation, the error is the pixel size is multiplied by 2   (approx. 1.41)
•	 Magnification Ratio:  1.0
•	 Pixel size (resolution):  0.1 mm
•	 Coordinates for first pixel clicked:  ( X1 , Y1 ) = ( 2, 2 )
•	 Coordinates for second pixel:  ( X2 , Y2 ) = ( 5, 5 )

（ X2 － X1 ） 
2 + （ Y2 － Y1 ） 

2

Magnification Ratio
=　Pixel Size ×Distance
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(X1,Y1) = (2, 2)

(X2,Y2) = (2, 2)

*	The dotted lines [ — ] indicate the coordinate axis of the pixel’s position.
The large heavy bordered squares [  ] are pixels.
The red frame indicates the first pixel clicked.
The red dot indicates the coordinate position of the first pixel.
The green frame indicates the second pixel clicked. 
The green dot indicates the coordinate position of the second pixel.

The length of the black line is calculated as follows:

 

Since the calculation depends on the coordinates of the pixels, the measurement error is shown below.
There will be a measurement deviation of the pixel size 2  (approx. 1.41 times) between the distance between 
clicked pixels (the blue line) and the calculated distance (the black line).

 ● Calculation error 2
In the following calculation, the error is the size of one pixel.
•	 Magnification Ratio:  1.0
•	 Pixel size (resolution):  0.1 mm
•	 Coordinates for first pixel clicked:  ( X1 , Y1 ) = ( 2, 4 )
•	 Coordinates for second pixel:  ( X2 , Y2 ) = ( 5, 4 )

(X1,Y1) = (1, 4) (X2,Y2) = (6, 4)

（ 5－ 2 ） 
2 + （ 5－ 2 ） 

2

1.0
=　0.3 　2 ≒ 0.42 (mm)=　0.1 ×Length
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The length of the black line is calculated as follows:
 

Since the calculation depends on the coordinates of the pixels, the measurement error is shown above.  The 
calculated distance is show by the blue line in the diagram above and, compared to the true distance shown by 
the black line, it is longer by one pixel.

16.2.2  Measurement errors due to exposure principles
There is some distortion in images due to the principles of exposure technique.  This distortion must be taken 
into consideration to make an accurate measurement.

Also, the magnification ratio may be other than specified if the patient is not properly positioned.  In this case, an 
accurate measurement cannot be made.

Below are some examples of image distortion for intraoral X-rays, panorama X-rays and CT slice images. 

	Intraoral X-ray

Maxillary incisor X-ray using the bifurcation method.
If the bifurcation line (the line than bifurcates the angle between the tooth axis and the image plate) is not 90 
degrees to the X-ray beam, there will be some difference between the actual length and the exposure length.

The diagram below is for a maxillary incisor.

Labial Side

Palatal Side

Actual Length

（ 6－ 1 ） 
2 + （ 4－ 4 ） 

2

1.0
=　0.5 (mm)=　0.1 ×Length
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 ● For 90 degrees
Exposure length equals actual length.

X-Ray Beam direction Tooth Axis

Bifurcation Line

Image Plate

Exposure Length
Actual Length

 ● For less than 90 degrees
Exposure length is shorter than actual length.

X-Ray Beam direction
Tooth Axis

Bifurcation Line

Image Plate

Actual Length

Exposure Length

 ● For more than 90 degrees
Exposure length is longer.

X-Ray Beam direction

Tooth Axis

Bifurcation Line

Image Plate

Exposure Length
Actual Length
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Maxillary molar X-ray using the bifurcation method.
Depending on the angle of the tooth axis, there will be some difference between the actual length and the 
exposure length.
The diagram below is for a maxillary molar.

 ● Positioned with the center of the molar as the tooth axis
The buccal side roots appear shorter and the lingual side root appears longer.

 ● Positioned with the buccal side as the tooth axis
The lingual side root appears longer.

Lingual Side Root

Buccal Side Roots

Buccal Side Palatal Side 

Exposure
Image

Exposure
Image

ToothTooth Axis

Bifurcation 
Line

Image 
Plate

X-Ray 
Beam 

direction

X-Ray 
Beam 

direction

Exposure
Image

Exposure
Image

Tooth
Tooth Axis

Bifurcation 
Line

Image 
Plate
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 ● Positioned with the lingual side as the tooth axis
The buccal side roots appear longer.

	Panorama X-Ray Image
In the diagram below, the red region is the image layer and the gray region is the dental arch.  In this case the 
magnification ratio will be as specified.

If the image layer is not positioned as shown in the diagram above, the magnification ratio of the image will be 
larger or smaller.  

X-Ray 
Beam 

direction

Exposure
Image

Exposure
Image

Tooth

Tooth Axis

Bifurcation 
Line

Image 
Plate

X-Ray Beam Source

Exposure Surface

Magnification Ratio : A
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 ● If dental arch is closer to the exposure surface
The magnification ratio will be smaller.

 ● If dental arch is closer to the X-ray beam source
The magnification ratio will be larger.

Also if the tooth axis is not perpendicular to the X-ray beam, the tooth will appear shorter than it really is.
Then there will be a difference between the measured length and the actual length of the tooth, and an accurate 
measurement cannot be made.

X-Ray Beam 
Source

X-Ray Beam 
Source

Exposure
Surface

Exposure
Surface

Magnification Ratio : A Magnification Ratio : It is less than A.

Magnification Ratio : A Magnification Ratio : It is less than A.

X-Ray Beam 
Source

X-Ray Beam 
Source

Exposure
Surface

Exposure
Surface

Exposure 
Surface

X-Ray Beam direction

Tooth Axis

Exposure 
Length

Actual Length
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	CT Slice Images

CT slices may be distorted depending on the slice thickness and exposure artifacts.  This is explained below.

 ● Thickness of Slice Data
CT volume data is generated after the exposure.
Then slices are made using the volume data.
The slice images have a certain thickness.

The thickness of the slices creates some distortion in the three dimensional quality of the CT slice data, and this 
is reflected in the slice image.

CT Volume DataCT Volume Data CT Slice ImageCT Slice Image

CT Slice CT Slice 
ImageImage

CT Slice DataCT Slice Data

CT Slice DataCT Slice Data

CT Slice Data

CT Slice Image
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When measuring the target on a CT slice image which has been distorted by the thickness of the slice, the 
measurement error is only in the vertical direction.

	CT Exposure Artifacts

Artifacts generated during a CT exposure may cause distortion of the slice images.
This distortion must be taken into consideration to make accurate measurements.
For details, refer to the Cautionary Remarks on Imaging in the Instructions for Use of your X-ray equipment.

CT Slice Data

CT Slice Image

Measured 
Length

Actual 
Length
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16.3  Image Size Technical Information for Distance 
Measurement, Printing, and Image Export

Generally, the imaging system for the radiography is as shown below.

In case of distance measurement on the screen, the distance is measured at the position of object. 

In case of printing by the print magnification of 1.0, the size of the printed image is equal to the size of the object.
When the size of the object is 100 mm, the size of the printed image is 100 mm. To print a cephalometric image 
in the same manner for printing a film-taken image, set the print magnification to 1.1.

When an image is exported, the DPI value is saved in the exported image file.  The DPI value is the DPI value 
on the image plane. If a file of an exported cephalometric image is processed on any other analysis software, 
the file is processed in the same manner for processing a file of an image acquired by scanning a film. 

The definition of the terms, “pixel size" and “magnification ratio,” used on this software is as follows:
•	Pixel size: Size of pixel on the image plane
•	Magnification ratio: (A + B)/A

In case of CT, however, the magnification ratio is always 1 and the pixel size means the pixel size of 
reconstructed slices. 

16.4  Technical Information for Panoramic Image 
Magnification Ratio

A standard panorama has a magnification of 1.3X.  Therefore, for a film exposure, the image layer will 
be magnified 1.3X. 
However, digital images are calibrated to be the same size as the image-layer (i.e., not magnified).  This makes 
it easier to use the image to make measurements etc.  (See the Note 1 below.)
(NOTE 1)	 Distance measurements on panorama images cannot be exact and should only be used as 

estimates.

X ray source

A B

H
H'

Object

Image plane

Image-Layer Sensor
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16.5  Technical Information for Image Magnification Ratio 
and Distance Measurement Accuracy

With i-Dixel, distance measurements are calculated according to magnification ratio and resolution. 
For accurate measurements require accurate magnification ratios and resolutions.
Since the magnification ratio for panorama images cannot be precisely known, measurements can only be 
approximate and this must be taken into consideration when using them. 

•	Great care must be taken when making measurements for implant planning etc.
•	Magnification ratios for panorama images may not be precise. 
•	Measurements made using panorama images are not exact and should only be considered estimates.  Care should be 

exercised when using these measurements.

16.6  Symbols
*	Some symbols may not be used.

Manufacturer Unique device identifier

Medical device GS1 DataMatrix

Refer to instructions for use

Prescription Device
Caution: Federal law restricts this device 
to sale by or on the order of a medical 
doctor, a dentist and a licensed healthcare 
practitioner. (Valid only for U.S.A.)

CE marking
Conforms with the European Regulation,  
EU 2017/745

EU Authorized Representative under 
the European Regulation, EU 2017/745 
(Valid only for EU)

REPCH
Authorized representative in 
Switzerland Packaging unit

Importer Distributor

Consult instructions for use or 
electronic instructions for use

cTUVus certification mark 
(Valid only for U.S.A. and Canada)

(Examples)

Country or region 
(Country Names: Conforming to the ISO 3166-1 alpha-3 codes and EU for European Union)
Description noted next to the code is an indication that conforms to the regulations valid only for the relevant 
country or region.

Registration number of medical device in Thailand
(The 12-digit sample number shown is for demonstration purposes only.)
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